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Abstract

This paper is a short introduction to using LATEX at Wabash College. It intro-
duces the basics of a LATEX document.
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1 Introduction

Have you ever tried to write a mathematical paper in Microsoft Word? Newer
versions of Word contain an equation editor that makes it possible, but you
probably find moving the mouse to click on each symbol annoying and tedious.
Don’t despair; there’s another way!

LATEX is the standard tool to typeset papers in mathematics, physics, eco-
nomics, and other disciplines. It is so common that most scientific and math-
ematical journals give special instructions on how to format articles for sub-
mission. In fact, it is very hard to find a mathematical journal that does not
explicitly prefer LATEX submissions over any other type of electronic submission.

LATEX is actually not a program. It is a set of macros for Donald Knuth’s
TEX typesetting program, which takes a plain text file encoded with special com-
mands and outputs a typeset document. Some people prefer to use plain TEX,
but we will concentrate on LATEX for its widespread use and ease of learning.

Because LATEX uses just plain text files, you will use the keyboard to input
everything. You might find this more difficult at first to remember all the
commands, but eventually you will find it much faster to write a mathematical
paper using LATEX than Microsoft Word.

The best way to learn LATEX is to experiment. Take a file that already works
and change it and see what happens. Use this document or any LATEX document
you find on the web. You can even start from scratch.

Throughout this paper, we describe the various parts of this document. Sec-
tion 2 describes how to get started on Wabash’s public Windows machines, and
Section 3 describes basic LATEX files and commands. Sections 4 and 6 describe
how to typeset mathematical equations and how to incorporate more advanced
environments such as automatic references, graphics, and floating figures and
tables. Finally, since we have only scratched the surface of LATEX’s capabilities,
Section 7 describes how to find more information.

2 Getting Started

To begin, you need only a few programs: a basic text editor and a LATEX pro-
cessor. On a Unix machine, one often runs these separately. For example, you
could run an editor such as emacs or vi to edit the file and then run the command
latex to process the file. You will find most LATEX documentation describing
this method. Because it is so widely described, and because you will likely use a
public Windows machine to typeset your document, we will concentrate on the
two integrated development environments (IDEs) installed on all public PCs on
campus: PCTeX and ProTeXt. Section 7 describes a website where you can
find links to other free and commercial versions of LATEX for any platform.
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2.1 PCTeX

Wabash College has a site license for the commercial software PCTeX. You can
find it on the public Windows machines under mathematics software. You can
also buy a personal copy from the website http://www.pctex.com, or you can
get a copy to evaluate free for 30 days. This might be a good way to use LATEX
on your personal computer in the short term.

Once you start the program, it acts like most standard Windows applica-
tions. You can use the File menu in the upper left to open LATEX files. PCTeX
comes with several sample files in a directory named samples. The public ma-
chines may open to it automatically. If not, look for a directory named PCTeX
on the local drive. The samples directory will be in it, probably a level or two
down.

After you have opened a LATEX file, or have created your own, you can typeset
it with the Typeset button in the middle of the row below the menus near the
top of the window. Be sure you see LATEX in the pull-down menu next to it. It
might not be activated yet. In which case, you need to go to the Typeset menu
and run INITeX. Choose the LATEX macros and then run INITeX.

By typesetting your document, you create a file called a DVI file that is
independent of the printer you will use. This file should appear, and you can
see the results of your efforts. You may encounter error in typesetting your
document. For example, we often find misspelled commands that LATEX doesn’t
understand. Fortunately, PCTeX will tell us where it encounters errors so we
can fix them.

You might also have to typeset the program a second time. This often hap-
pens when you are using LATEX’s automatic referencing capabilities. If PCTeX
suggests you typeset the document again, you should do it.

Once you successfully typeset your program and create a DVI file, you can
print it or you can export it to various document types. If you want to send
it to someone else, we suggest exporting it as a PDF file by using the Export
command in the File menu.

2.2 TeXworks

Wabash College also installed a copy of the free software TeXworks on all public
PCs. You can find it on the public Windows machines under mathematics
software:

Start / Courses / Mathematics / TeXworks .

You can also download a personal copy from the website http://www.tug.org.
This may be your best long-term way to use LATEX on your personal computer.

Once you start the program, it acts like most standard Windows applica-
tions. You can use the File menu in the upper left to open LATEX files. You
can use the ”New from Templates” entry in the File menu to open templates
or sample files.
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After you have opened a LATEX file, or have created your own, you can typeset
it with the click of a button. Look for the Typeset menu in the middle of the
menus near the top of the window. When you open the menu, you can choose
which program(s) you want to use to create the output. It will probably default
to pdfLaTeX+MakeIndex+BibTex. I suggest you either use that or pdfLaTeX.

You may encounter error in typesetting your document. For example, we
often find misspelled commands that LATEX doesn’t understand. Fortunately,
TeXworks will tell us where it encounters errors so we can fix them. Notice
the log at the bottom of the screen. At the very end, it should tell you how
many errors and warnings it encountered. Errors will keep your document from
compiling, while warnings will make it appear incorrectly. You must fix errors,
but you can ignore warnings if you do not care about the appearance. You can
scroll back up through the log to see what happened.

You might also have to typeset the program a second time. This often hap-
pens when you are using LATEX’s automatic referencing capabilities. TeXworks
will often automatically typeset the document a second time, but if you find
any undefined references—which will be marked by “??”–you might first try
typesetting it again.

2.3 LATEX on Your Personal Computer

You can also use LATEX on your personal computer. The TEX Users Group
website [9] contains information on many commercial and free TEX and LATEX
implementations for all operating systems. If you have a PC, you can install a
demo version of PCTeX on your computer, or you can other free versions such
as ProTeXt, TeX Live, fpTeX, emTeX, or MikTeX. On a Windows machine, I
I suggest you install the latest version version of MikTeX, which should come
with TeXworks. (You might also want to install Ghostscript and GSView to
view postscript files.) On a Mac, my colleagues in the Physics Department
suggest TeXShop., which is very similar to TeXworks. You can find its website
by searching on Google.

2.4 LATEX Online

It is becoming increasingly more popular to use LATEX online. Overleaf is an
online, collaboarative LATEX editor that is available for free for students. It also
has more advanced memberships with more features for a monthly or annual fee.
You can find it here: https://www.overleaf.com/. It also has documentation
to help you learn LATEX at https://www.overleaf.com/learn.

Overleaf may act a little differently from the other compilers I mentioned
above. In particular, students have told me the behavior of the Q.E.D. symbol
differs from what I describe in Section 5.1, and that the \qedhere command is
not supported.

In order to submit an assignment that you write in Overleaf, you will proba-
bly need to download the output or possibly the source file. You can download
either of them by clicking on the Menu button at the top left of the proejct
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screen. The source files will be in a zipper file, which you may need to extract.
The output should be in a single PDF file.

3 Basic LATEX

3.1 Commands and Comments

As you look at any LATEX file, you will see various funny-looking strings of
letters. In several places, you will see the character %. This signifies the rest of
the line is a comment, which LATEX will ignore. You can use comments to take
out statements you no longer want, or to document your work.

LATEX commands begin with the character \ and run until the first whites-
pace. Some commands require arguments, such as the \documentclass{...}

command that begins the file. Other commands, such as \maketitle require
no arguments. For example, we can print the special word LATEX with the com-
mand \LaTeX. However, LATEX recognizes the whitespace after the command as
ending the command, not as space between words. Notice there is no space after
the word LATEXin this sentence. For this reason, we use the braces { and } to
keep the command and the whitespace separate. Notice, throughout the file we
use the command \LaTeX{}. We could have also used the command {\LaTeX}

to achieve the same result.

3.2 File Layout

Every LATEX file consists of two parts: the preamble and the body. The preamble
begins with the \documentclass, usually the first line of the file, and sets certain
information about the document. In this case, the command

\documentclass{article}

says we are writing an article. The command also may take options. For
example, we could use the command \documentclass[12pt]{...} to indicate
a 12 point font, or \documentclass[10pt,a4paper]{...} to indicate 10 point
font on A4 paper. We could have also used \documentclass{report} to create
a report or \documentclass{book} to create a book. Different document classes
behave differently. We will concentrate on the article class here. Our preamble
also includes commands to use additional packages.

The body begins with the command \begin{document} and ends with the
command \end{document}, and it contains all the text of the document. LATEX
will ignore anything after the \end{document} command.

3.3 Titles, Authors, Dates

The command \maketitle that appears near the beginning of the body of our
file tells LATEX to make the title for the document. It uses information that
we input in commands \title{...}, \author{...}, and possibly \date{...}
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sometime before the \maketitle command. We placed these commands in the
preamble, but we could have just as easily placed them in the body before the
\maketitle command.

LATEX requires us to use two of these commands: namely \title{...} and
\author{...}. The \date{...} is special because LATEX will use today’s date
if we don’t specify a date. You might not specify a date so LATEX will tell you
the date you last LATEXed the file, or you might want to specify the date so
LATEX will not change it on you.

3.4 Sections

You can divide a LATEX document into sections using the \section{...} com-
mand. This command automatically numbers the sections using an internal
counter. LATEX also has other sectioning commands to produce other levels of
headings. Descending for \section{...}, LATEX also has the commands

\subsection{...}

\subsubsection{...}

\paragraph{...}

\subparagraph{...}

for increasingly finer divisions.
Each of these sectioning commands also has an unnumbered version

\section*{...}

\subsection*{...}

\subsubsection*{...}

\paragraph*{...}

\subparagraph*{...}

These commands produces the same heading style without a counter. For exam-
ple, the References section after Section 7 is produced with in this way, although
the mechanism is actually hidden within the \bibliography{...} command.
You might find this useful for typesetting your homework where you might not
want the section numbers to appear.

LATEX also has a \part command that lies above the \section command
in this hierarchy. The book and report classes also have a \chapter command
between parts and sections.

This automatic numbering is helpful when you rearrange sections. It is
also useful when you want to automatically reference a section as described in
Section 6.5. You can also create a table of contents, although you will probably
not encounter that in a paper.

3.5 Words, Paragraphs, and Whitespace

LATEX interprets blank spaces, tabs, and carriage returns as the end of words
and commands. It does not matter how many spaces or tabs you put between
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words or commands. LATEX will ignore this when it places the space between
words in the final output. This means you can leave whitespace (for example
through indenting a line) only for your own convenience.

LATEX interprets one or more empty lines as the end of a paragraph. Once
again, the spacing between paragraphs is independent of the number of empty
lines. However, you can only leave a blank line if you want to start a new
paragraph. If you want to leave a blank line for your convenience without
starting a new paragraph, you can cheat by making the line contain a blank
comment by starting it with a comment character %. (See Section 3.1.)

LATEX treats each paragraph as one long string of words. It then breaks up
lines automatically independent of the input, and makes the spacing between
the words on each line as uniform as possible so that each line is left and right
justified. It will also automatically space and indent each paragraph based upon
the document class in use.

3.6 Quotation Marks

Another trick you might encounter is placing quotation marks around a sentence.
LATEX recognizes a difference between ’ and ‘, and it usually interprets " as
’’. The make the quotation marks appear normally, use ‘‘ and ’’ to quote
material. For example, ‘‘this’’ produces “this.”

3.7 Tables

Sometimes you might want to put information in a table. To do so, you can use
the tabular environment. For example, the text

\begin{tabular}{lccr}

Name & Test 1 & Test 2 & Average \\

Bob & 90 & 80 & 85 \\

Joe & 60 & 90 & 75

\end{tabular}

produces the table
Name Test 1 Test 2 Average
Bob 90 80 85
Joe 60 90 75

Be sure to leave a blank line before and after the environment so it doesn’t
place the table inside a paragraph.

Here the command \begin{tabular}{lccr} begins the tabular environment
and tells LATEX to make the table have four columns. The {lccr} says first one
is left-justified, the middle two are centered, and the last is right-justified. The
command \end{tabular} ends the tabular environment. Between these two
commands, we place the body of the matrix in a row-major form where we read
across each row before going to the next row. We separate the entries of each
row with ampersands & and separate each line with the newline command \\.
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We can also place vertical and horizontal lines between the rows and columns
of the table. We place vertical lines between the columns by placing a | between
the justification indicators at the beginning of the environment. We place hor-
izontal lines between the rows by using the \hline command. This command
must come one a new line, so be sure to end any line before it with the newline
command \\. For example, the text

\begin{tabular}{||l|c|c|r||}

\hline

\hline

Name & Test 1 & Test 2 & Average \\

\hline

Bob & 90 & 80 & 85 \\

Joe & 60 & 90 & 75 \\

\hline

\hline

\end{tabular}

produces the table

Name Test 1 Test 2 Average
Bob 90 80 85
Joe 60 90 75

4 Mathematics

LATEX handles mathematical equations with ease. You enter mathematical equa-
tions by switching to math mode.

4.1 Text and Display Styles

LATEX has type types of mathematical equations: text and display styles. LATEX
changes slightly how equations are displayed depending on the style, but you
enter mathematics the same way in both.

You can enter equations in text style to occur in the line of the text by placing
a dollar sign $ on either side. For example, $x + y = z$ produces x + y = z.
You can also enter equations in display style to occur centered on their own
line by placing two dollar signs $$ on either side. For example, $$x + y = z$$

produces
x+ y = z

4.2 AMS LATEX

The American Mathematical Society created additional LATEX macros to make
typesetting mathematical equations even easier [1]. In this document, we are us-
ing the amsmath, amsfont, and amssymb packages. The manual for the amsmath
package [3] describes more features of this package than we will go into here. In
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particular, you might be interested in how to number equations, how to split
equations over several lines in display mode, or how to create new mathemat-
ical operators such as sin. The AMS also created a short guide to typesetting
mathematics with these three packages [2].

The AMS also has a fourth package, amsthm, that you can use to typeset
theorems and proofs [4]. You might find these features more useful in theory
classes and when writing research papers. See Section 5.2 for more information.

4.3 Superscripts and Subscripts

To enter a superscript such as in an exponent, you use the ^ character. For
example, e^x produces ex. To use more complicate exponents, you must group
the exponent with braces. For example, e^{x+1} produces ex+1.

Similarly you can enter subscripts with the _ character. For example, x_0
produces x0, and x_{i+3} produces xi+3.

4.4 Binary Relations and Negations

We can compare two mathematical quantities by connecting them with a rela-
tion such as =, ≤, or ∝. Table 3 in Appendix A lists several common binary
operators and relations.

We can indicate the opposite, or negated, meaning of the relation with a
slash ’/’ through the symbol. We can do this in LATEX by putting a \not before
the relation command. For example, \leq produces ≤, and \not\leq produces
̸≤. Similarly \not= produces ̸=, and \not> produces ̸>. LATEX also has a few
negated symbols already, such as \neq, which produces ̸=, and \notin, which
produces /∈.

4.5 Function Names

In math mode, LATEX interprets strings of characters as separate variables. For
example, sin(x) produces sin(x), which should be read as s × i × n × (x).
This is probably not what you want to happen. Instead, you might use one of
LATEX’s built-in operators such as \sin. In this case, \sin(x) produces sin(x).
Most mathematical functions you know have operators in LATEX. (See Table 6
in Appendix A.)

You can attach limits to some of these functions, such as \min, \max, and
\lim, through the subscript command. For example \lim_{x \to a} x^2 pro-
duces limx→a x

2 and
lim
x→a

x2.

4.6 Integrals, Sums, etc

Use the command \int to produce the integral sign in LATEX. For example, you
might use \int x^3 \ dx to produce

∫
x3 dx. Here I use the “\ ” to produce

an extra space between the x3 and the dx to emphasize the dx. To produce
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the limits of a definite integral, just use the super- and subscripts described in

Section 4.3. For example, \int_0^{10} x^3 \ dx produces
∫ 10

0
x3 dx in text

mode and ∫ 10

0

x3 dx

in display mode.
Similarly you can use \sum to produce a summation. For example,

\sum_{k=0}^{10} k^3

produces
∑10

k=0 k
3 and

10∑
k=0

k3.

LATEX also has a \prod command for products.

4.7 Fractions

To enter fractions in text mode, you may want to use the slash / such as x/y.
However, in display mode you probably want a horizontal bar such as

x

y
.

You can accomplish this by using the \frac{...}{...} command. For exam-
ple, we used \frac{x}{y} to produce this fraction. You can use much more
complicated expressions in both the numerator and denominator, such as dy

dx or

ex

x3 + 5x− 1
.

4.8 Automatic Sizing of Bracket Symbols

Often in mathematical writing you want to use bracketing symbols, usually in
pairs to enclose part of a formula. To make these symbols an appropriate size
for the enclosed formula, LATEX provides a pair of commands \left and \right.
To use these commands, you place them immediately before the corresponding
left- and right-hand bracketing symbols. For example,

\left[ \frac{1}{4} x^4 \right]_0^{10}

produces
[
1
4x

4
]10
0

and [
1

4
x4

]10
0

.

The bracketing symbols don’t have to match, but you do have to use both
the \left and \right commands. For example, you could use the command
\left| \int \right( to produce

∣∣∫ (, although it usually doesn’t make sense
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to mix the brackets. Table 7 in Appendix A provides a list of delimiters you
can use for this purpose.

Sometimes you might want an invisible bracket. You can do this by using a
period ‘.’ as the bracketing symbol. For example, we can use

\int_0^{10} x^3 \ dx

= \left. \frac{1}{4} x^4 \right|_0^{10}

to produce ∫ 10

0

x3 dx =
1

4
x4

∣∣∣∣10
0

.

Another case where you might use this is for a piece-wise defined function.
For example,

y = \left\{

\begin{array}{r@{\quad:\quad}l}

-1 & x < 0, \\

0 & x = 0, \\

+1 & x > 0.

\end{array}

\right.

produces

y =

 −1 : x < 0,
0 : x = 0,

+1 : x > 0.

Here, we used \{ to produce the opening brace. Notice the escape character
\, which LATEX requires to produce the symbol because otherwise it thinks of
it as grouping things together. We also used the array environment, which is
basically a tabular environment in math mode. We also used the command
@{\quad:\quad} to produce the spacing (by \quad) and the colon between the
two columns of the array. AMS-LATEX provides another way to do define a
piecewise function this using a cases environment. For example,

y = \begin{cases}

-1, & \text{if } x < 0, \\

0, & \text{if } x = 0, \\

+1, & \text{if } x > 0.

\end{cases}

produces

y =


−1, if x < 0,

0, if x = 0,

+1, if x > 0.
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4.9 Matrices

We actually have a couple of ways to produce matrices in our papers. We
could use the bracketing symbols and arrays as we did for the piece-wise defined
functions in Section 4.8. This requires us to know how many columns are needed
before we start writing the matrix.

The amsmath package gives us another way to incorporate matrices into
our papers. We can do this by using one of several matrix environments. For
example, the text

$$

\begin{pmatrix}

a & b \\

c & d

\end{pmatrix}

$$

produces the output (
a b
c d

)
Here the command \begin{pmatrix} begins the pmatrix environment and

the command \end{pmatrix} ends the pmatrix environment. Between these
two commands, we place the body of the matrix in a row-major form where we
read across each row before going to the next row. We separate the entries of
each row with ampersands & and separate each line with the newline command
\\. AMS-LATEX has other environments to surround the matrices with brackets
(bmatrix :

[
a
]
), braces (Bmatrix :

{
a
}
), single lines (vmatrix :

∣∣a∣∣), and double

lines (Vmatrix :
∥∥a∥∥).

4.10 Other Useful Commands

Finally, we present a few other mathematical commands you might find use-
ful. You might use the command \sqrt{...} to produce a square-root as
in
√
x2 + 1. You can produce a cube-root with this command. For example,

\sqrt[3]{...} produces 3
√
x2 + 1. Here the brackets designate an optional

parameter to the command.
In combinatorics or statistics, the command {a \choose b} might be useful

to produce
(
a
b

)
. This command is really a TEX command, and so its format

differs from the LATEX commands in the rest of this paper. In this command,
the braces are important to let the \choose command know what goes above
and below it. The command \atop produces the same output without the
parentheses. For example, a

b .
Appendix A includes a few tables of mathematical symbols you might find

useful, as well as how to use other alphabets to produce symbols such as R and
Z.
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5 Theorems and Proofs Using the amsthm Pack-
age

Perhaps the simplest way to incorporate theorems and proofs into a LATEX paper
is to use the amsthm package. This package provides a predefined proof environ-
ment and the ability to define environments for theorems, lemmas, corollaries,
propositions, definitions, examples, remarks, notes, etc.

The first thing you must do is load the package in the preamble by using the
command

\usepackage{amsthm}

Unlike other AMS packages, the amsmath package does not automatically load
it.

5.1 Proofs

Once you have access to the proof environment.

\begin{proof}

...

\end{proof}

This environment provides an unnumbered structure with the title Proof. The
environment terminates with the Q.E.D. symbol . You may alter the symbol
by redefining the \qedsymbol command, and you may print it at any time with
the command \qed.

Normally the Q.E.D. symbol appears on the last line of text flush with the
right margin:

Proof. ... Thus the proof is complete.

However, if a proof ends with an equation in display mode, the Q.E.D. symbol
will appear on the next line by itself:

Proof. ... Thus we get the equation

x2 + y2 = z2.

To avoid this you may use the \qedhere command within the math mode for
the final equation to force the Q.E.D. symbol to appear immediately after the
equation:

Proof. ... Thus we get the equation

x2 + y2 = z2.
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5.2 Theorem-Type Environments

The amsthm package does not directly provide any environments for writing
theorems, but you may easily create them with the \newtheorem command.
For example, the command

\newtheorem{theorem}{Theorem}

provides a theorem environment

\begin{theorem}

...

\end{theorem}

that has the numbered Theorem label. Similarly you can create any other
theorem-like environments you want. For example, the commands

\newtheorem{lemma}{Lemma}

\newtheorem{corollary}{Corollary}

create environments labeled Lemma and Corollary.

5.3 Changing Numbers

By default, every theorem-like environment uses different numbering sequences
and are number sequentially throughout the document. For example, the code
used in the previous section provides environments numbered Theorem 1, The-
orem 2, Lemma 1, Lemma 2, Corollary 1, Corollary 2, etc. The \newtheorem

command takes two optional arguments to change this. Be careful, you cannot
use both of these optional arguments at the same time.

If the optional argument of an existing theorem-like definition comes before
the new title, the new environment will be numbered in the same sequence as
the first. For example, the code

\newtheorem{theorem}{Theorem}

\newtheorem{lemma}[theorem]{Lemma}

\newtheorem{corollary}[theorem]{Corollary}

provides environments numbered Theorem 1, Theorem 2, Lemma 3, Lemma 4,
Corollary 5, Corollary 6, etc.

On the other hand, if the optional argument of a counter name like chapter
or section appears after the new title, incrementing this counter will reset the
counter of the environment. For example, the code

\newtheorem{theorem}{Theorem}[section]

will provide an environment numbered within sections as in Theorem 1.1, The-
orem 1.2, Theorem 2.1, Theorem 3.1, etc.
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5.4 Theorem Styles

The package has three predefined theorem styles:

plain The title and number are in bold and the text italic.

definition The title and number are in bold and the text normal.

remark The title and number are in italic and the text normal.

By default, the amsthm package uses the plain theorem style, but you may use
the \theoremstyle command to activate a new style. The package will use this
style until the next style is activated. For example, the code

\newtheorem{theorem}{Theorem}

\newtheorem{lemma}{Lemma}

\theoremstyle{definition}

\newtheorem{definition}{Definition}

\newtheorem{example}{Example}

\theoremstyle{remark}

\newtheorem{remark}{Remark}

\newtheorem{note}{Note}

creates six environments. The first two, theorem and lemma use the plain style;
the middle two, definition and example use the definition style; and the last
two, remark and note use the remark style

5.5 Specific Names

Sometimes you might want to add a specific name to a theorem or proof. To
do so, use an optional argument when you start the environment. For example,
replace the commands

\begin{theorem} ... \end{theorem}

\begin{proof} ... \end{proof}

with

\begin{theorem}[Theorem Name] ... \end{theorem}

\begin{proof}[Proof of Theorem Name] ... \end{proof}

The theorem will add the optional name in parentheses after the numbered
label, and the proof will replace the title with the optional one.

5.6 Examples

Sections 5.6.1 and 5.6.2 provide examples of the theorem and proof environ-
ments. Section 5.6.1 uses the standard environments described in Section 5.2,
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and Section 5.6.2 uses the environments with optional arguments to include
specific names described in Section 5.5.

All of these examples come in modified versions from Section 1.2 of An
Introduction to the Theory of Numbers, Fifth Edition, by Ivan Niven, Herbert
S. Zuckerman, and Hugh L. Montgomery.

5.6.1 Divisibility

Definition 1. An integer b is divisible by an integer a ̸= 0 if there exists and
integer x such that b = ax. We write a | b. In case b is not divisible by a, we
write a ∤ b.

Instead of saying b is divisible by a, we may also say that a divides b, that
a is a divisor of b, or that b is a multiple of a. If a | b and 0 < a < b, then
a is called a proper divisor of b. it is understood that we never use 0 as the
left member of the pair of integers in a | b. On the other hand, not only may
0 occur as the right member of the pair, but also in such instances we always
have divisibility. Thus, a | 0 for every integer a ̸= 0.

Lemma 1.

1. a | b implies a | bc for any integer c;

2. a | b and b | c imply a | c;

3. a | b and a | c imply a | (bx+ cy) for any integers x and y;

4. a | b and b | a imply a = ±b;

5. a | b and b > 0 imply a ≤ b;

6. if m ̸= 0, then a | b implies and is implied by ma | mb.

The proofs of these results follow from the definition of divisibility.
The next result is a formal statement of the outcome when an integer b is

divided by any positive integer. For example, if 25 is divided by 7, the quotient is
3 and the remainder is 4. These numbers are related by the equality 25 = 7·3+4.
Now we reformulate this in the general case.

Theorem 1. The division algorithm. Given any integers a and b, with a > 0,
there exist unique integers q and r such that b = qa+ r and 0 ≤ r < a. If a ∤ b,
then r satisfies the stronger inequalities 0 < r < a.

Proof. Consider the arithmetic progression

. . . , b− 3a, b− 2a, b− a, b, b+ a, b+ 2a, b+ 3a, · · ·

extending indefinitely in both directions. In this sequence, select the smallest
nonnegative member and denote it r. Thus by definition r satisfies the inequal-
ities of the theorem, but also r, being in the sequence, is of the form b− qa, and
thus q is defined in terms of r.
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To prove uniqueness of q and r, suppose there is another pair q1 and r1
satisfying the same conditions. First we prove r1 = r. For if not, we may
presume r < r1 so that 0 < r1 − r < a, and then we see that r1 − r = a(q − q1)
and so a | (r1 − r), a contradiction to Lemma 1. Hence r = r1 and q = q1.

We stated the theorem with the assumption a > 0. This hypothesis is not
necessary, and we may reformulate the theorem without it: given any integers
a and b, with a ̸= 0, there exist unique integers q and r such that b = qa + r
and 0 ≤ r < |a|.

5.6.2 Greatest Common Divisor

Definition 2 (Greatest Common Divisor). The integer a is a common divisor
of b and c in case a | b and a | c. Since there is only a finite number of divisors of
any nonzero integer, there is only a finite number of common divisors of b and
c, except in the case b = c = 0. If at least one of b and c is not zero, the greatest
among their common divisors is called the greatest common divisor of b and c
and is denoted gcd(b, c). Similarly we denote the greatest common divisor g of
the integers b1, b2, . . . bn, not all zero, by gcd(b1, b2, . . . bn).

Theorem 2 (Greatest Common Divisor as Linear Combination). If g is the
greatest common divisor of b and c, then there exist integers x0 and y0 such that
g = gcd(b, c) = bx0 + cy0.

Another way to state this very fundamental result is that the greatest com-
mon divisor of two integers b and c is expressible as a linear combination of b
and c with integral multipliers x0 and y0. This assertion holds for not just two
integers but for any finite collection.

Proof of Theorem 2. Consider the linear combinations bx + cy where x and y
range over all integers. This set of integers {bx + cy} includes positive and
negative values, and also 0 by the choice x = y = 0. Choose x0 and y0 so that
bx0 + cy0 is the least positive integer ℓ in the set; thus ℓ = bx0 + cy0.

Next we prove ℓ | b and ℓ | c. We establish the first of these, and the second
follows by analogy. We give an indirect proof that ℓ | b; that is, we assume ℓ ∤ b
and obtain a contradiction. From ℓ ∤ b it follows by Theorem 1 that there exist
integers q and r such that b = ℓq + r and 0 < r < ℓ. Hence we have

r = b− ℓq = b− q(bx0 + cy0) = b(1− qx0) + c(−qy0)

and thus r is in the set {bx + cy}. This contradicts the fact that ℓ is the least
positive integer in the set {bx+ cy}.

Now since g is the greatest common divisor of b and c, we may write b = gB,
c = gC, and

ℓ = bx0 + cy0 = g(Bx0 + Cy0).

Thus, g | ℓ, and so by Lemma 1 we conclude that g ≤ ℓ. Now g < ℓ is impossible
since g is the greatest common divisor, so

g = ℓ = bx0 + cy0.
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6 More Advanced Topics

In this section, we introduce a few advanced topics that may make your papers
easier to create and read. We only scratch the surface. Please see Section 7 for
how to learn even more.

6.1 References

LATEX allows us to embed automatic references into our document. For example,
the \section{...} command not only formats the section title and assigns it
a number from a counter, it also sets that counter so that we can reference it.
When we started Section 1, we placed the command \label{intro} immedi-
ately after the \section{Introduction} command. We can now reference that
section anywhere in the document by using the \ref{intro} command. For
example, we can use Section~\ref{intro} to reference Section 1. The ~ is a
non-breaking space and forces the section number to lie on the same line as the
word “Section.”

Similarly we can reference other divisions of the paper, theorems, definitions,
equations if we use AMS-LATEX to number them, figures and other floating
environments described in Section 6.4. However, we must ensure each label has
a unique marker. Also, the way LATEX handles this automatic referencing often
requires us to process the file a second or third time to get all the references
right. Otherwise, LATEX leaves ?? for references it doesn’t understand.

6.2 Spaces, Lengths, and Dimensions

LATEX contains commands to provide extra spacing. The \hspace and \vspace

command inserts horizontal and vertical spacing, respectively, into your doc-
ument. Both of these commands take an argument to specify the length of
the space. A length, which may be positive or negative, is a decimal number
followed by a dimensional unit. Permissible dimensions include in, cm, mm, em
(the width of the letter ’M’), and ex (the height of the letter ’x’). For example,
\hspace{2.5in} inserts two and a half inches of horizontal space. Similarly
\vspace{-3.6cm} inserts negative 3.6 cm of vertical space. The starred ver-
sions of the commands insert space even at the beginning of the line or page.
For example, \vspace*{3in} leaves three inches of vertical space, even at the
beginning of the page, whereas \vspace{3in} only works if it is not at the
beginning of the page.

6.3 Including Graphics

The easiest way to include graphics in a LATEX document is by using the graphicx
package. You may use this package to include an image that you have already
created. You may create this image with any graphics program, but you should
save it as an encapsulated postscript (EPS) file. Once you have saved the EPS
file, you can use the \includegraphics{...} command to include it in your
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document. For example, we have the image file radix3_network_2 from a paper
we wrote. We can use the command

\centerline{\includegraphics{radix3_network_2}}

to include it as so:

Here, the \centerline command centers the image on the line. Be sure
to leave a blank line before and after this so it doesn’t put it at the end or
beginning of a paragraph.

The \includegraphics command also takes some optional arguments. You
might find the scale option to scale the image. For example,

\centerline{\includegraphics[scale=0.5]{radix3_network_2}}

produces the following image that is scaled to half the original size.

You can also include more than one image on a line. The commands

\centerline{

\includegraphics[scale=0.5]{radix3_network_2}

\quad

\includegraphics[scale=0.5]{radix3_network_2}

}

produces the following pair of images. Here \quad produces a little spacing
between the images.

6.4 Floating Environments

Unfortunately, image files are not smart enough to break to a new page, and
you may lose part of your image if you place it too close to the end of a page.
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The solution is to use a floating environment called the figure environment. A
floating environment floats to a convenient location in the document. You can
specify where to allow the figure, and LATEX will accommodate you as best it
can. For example, the text

\begin{figure}[hbtp]

\centerline{\includegraphics{radix3_network_2}}

\caption{A test figure with the caption below.}

\label{test fig}

\end{figure}

produces the Figure 1.

Figure 1: A test figure with the caption below.

Here, the options [hbtp] tell LATEX to place the image here, at the bottom
of the page, at the top of the next page, or on a page of only images, in that
order of preference. You may remove some of these designators if you want to
limit where LATEX may place the image.

The \caption{...} command places a caption on the figure. It also updates
the figure counter, so be sure and place it before the \label{...} command. By
placing these commands at the end of the figure environment, we tell LATEX to
place the caption after the figure. If you prefer, you can place these commands
just after the \begin{figure} command to place the caption above the figure
as in Figure 2.

LATEX also has a table environment for tables.

6.5 Citations and the Bibliography

You may want to include a bibliography or list of references at the end of your
paper. Happily, LATEX will help you automatically generate a bibliography from
a database file, called a BIB file. (For example, Appendix 6.5 has the BIB file
for this paper.) This is another plain text file that contains information about
the sources you are using. A program called BibTeX takes the information from
the database and includes only the sources you cite.

In our document, we use the commands
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Figure 2: A test figure with the caption above.

\bibliographystyle{plain}

\bibliography{latex}

to tell LATEX what form the bibliography should take and where to find the
content. In this case, we are using the plain style, which alphabetizes the
entries by author and typefaces them in a certain way. A different style might
give a different typeface, a different method of sorting, or both.

The \bibliography{latex} tells LATEXto use the file latex.bib for the con-
tent information. This command may take more than one argument separated
by commas. For example, \bibliography{latex,foo} tells LATEX to also use
the file foo.bib

6.5.1 BIB Files

The BIB file contains an entry for each reference, and each reference has a cor-
responding type. For example, the BIB file for this document contains contains
one book with the code

@Book{guide,

author = "Helmut Kopka and Patrick W. Daly",

title = "Guide to {LaTeX}",

edition = "4th",

publisher = "Pearson Education",

address = "Upper Saddle River, NJ",

year = 2003

}

Here, guide is the label we use for citing this reference. It is followed by several
fields giving information about the book: its author, title, edition, publisher,
address, and year of publication. Four of these fields (author or editor, title,
publisher, and year) are required, and the others are optional. We could also
include fields for the volume or number, series, month, and note [6, Appendix
B]. Each field has a value given by either a number–as the year–or a string in
quotes. Notice the title contains {LaTeX} in the string. This forces LATEX to
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use this part of the string exactly as it appears instead of changing it to meet
whatever capitalization rules are specified in our particular bibliography style.

Our BIB file also contains one journal article [5]:

@Article{CEKSTV02,

author = "Li Chen

and Wayne Eberly

and Erich Kaltofen

and B. David Saunders

and William J. Turner

and Gilles Villard",

title = "Efficient Matrix Preconditioners for Black Box

Linear Algebra",

journal = "Linear Algebra and Applications",

volume = "343-344",

pages = "119--146",

note = "Special issue on \emph{Infinite Systems of

Linear Equations Finitely Specified}, edited by

P. Dewilde, V. Olshevsky and A. H. Sayed",

year = 2002,

month = "March"

}

This entry type requires four fields: author, title, journal, and year. All the
other fields are optional. Notice multiple authors are always separated by the
word “and.” This allows the BibTeX program to know how many authors the
paper has.

Our BIB file contains several entries for miscellaneous sources:

@Misc{tug,

title = "{\TeX} Users Group web page",

author = "{TeX Users Group}",

howpublished = "Web page",

note = "\url{http://www.tug.org}"

}

These entry types actually requires no fields, but you may specify authors, title,
year, month, how published, and note.

6.5.2 Citing Sources

To cite a source, we use the \cite{...} command. For example, the command
\cite{CEKSTV02} cites the article by Chen et al. [5]. We can also use optional
arguments to give a specific location in the citation. For example, the command
\cite[Theorem~6.1]{CEKSTV02} cites Theorem 6.1 of the article by Chen et al.
[5, Theorem 6.1] and the command \cite[Appendix~B]{guide} cites Appendix
B of the book by Kopka and Daly [6, Appendix B]. We can also cite several
sources at once as with the command \cite{guide, CEKSTV02}, which cites
the amsmath user’s guide and the AMS-LATEX website [6, 5].
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6.5.3 BibTeX

Once you have created a BIB file and cited some sources, you can use the BibTeX
program to create a bibliography. To do so, place the \bibliography{...}

command where you want the bibliography to appear and place the command
\bibliographystyle{...} anywhere before it. Then typeset the file once with
LATEX. Finally run BibTeX from the Tools menu and LATEX the file again at
least once or twice more.

6.5.4 Author-Year Bibliographies with natbib

The standard LATEX bibliography implementation numbers references and cites
them by their numbers. An alternative style that many journals and texts use
references works by citing the author’s name and year of publication. This may
take the familiar form of the APA style that many standard English style guides
include, or other related forms. There are a number of packages developed to
deal with this situation, but the most universal of these is the natbib package
by Patrick W. Daly. It is compatible with the standard bibliography styles as
well as a number of author-year styles. See §11.3.4 of the Guide to LaTeX by
Helmut Kopka and Patrick W. Daly [6] for more information.

7 More Information

You can easily find more information about LATEX. The TEX Users Group
maintains a website [9] that contains links to all the information you might
ever want to know about TEX and LATEX. You can find information about
obtaining freeware and commercial software for any computer platform, tutorials
and documents describing how to do anything you’d ever want to do, and books
about TEX and LATEX. If you are interested in a good book about LATEX, check
out the book Guide to LaTeX by Helmut Kopka and Patrick W. Daly [6].
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A Mathematical Symbols

The following tables give some of the basic mathematical symbols you might
want to use. They demonstrate some of the symbols normally accessible from
math mode. You can consult other LATEX references for more symbols. In partic-
ular, Oetiker [7] and Kopka and Daly [6] provide tables of mathematical symbols.
Perkins [8] provides one of the most comprehensive symbol lists available.

Table 1: Math Mode Accents.

â \hat{a} ǎ \check{a} ã \tilde{a} á \acute{a}

à \grave{a} ȧ \dot{a} ä \ddot{a} ă \breve{a}

ā \bar{a} a⃗ \vec{a} Â \widehat{A} Ã \widetilde{A}

25



Table 2: Greek Letters.

α \alpha θ \theta o o υ \upsilon

β \beta ϑ \vartheta π \pi ϕ \phi

γ \gamma ι \iota ϖ \varpi φ \varphi

δ \delta κ \kappa ρ \rho χ \chi

ϵ \epsilon λ \lambda ϱ \varrho ψ \psi

ε \varepsilon µ \mu σ \sigma ω \omega

ζ \zeta ν \nu ς \varsigma

η \eta ξ \xi τ \tau

Γ \Gamma Λ \Lambda Σ \Sigma Ψ \Psi

∆ \Delta Ξ \Xi Υ \Upsilon Ω \Omega

Θ \Theta Π \Pi Φ \Phi

Table 3: Binary Relations and Operators.
You can negate the following symbols by prefixing them with a \not command.
The \nmid command requires the amssymb package.

< < > > = =

≤ \leq or \le ≥ \geq or \ge ̸= \neq or \ne

≪ \ll ≫ \gg ≡ \equiv

⊂ \subset ⊃ \supset ≈ \approx

⊆ \subseteq ⊇ \supseteq ∼= \cong

∈ \in ∋ \ni , \owns /∈ \notin

| \mid ∤ \nmid ∥ \parallel

⊥ \perp : : ∝ \propto

+ + − - ◦ \circ

± \pm ∓ \mp ∗ \ast

· \cdot ÷ \div • \bullet

× \times \ \setminus † \dagger

∪ \cup ∩ \cap ‡ \ddagger

∨ \vee , \lor ∧ \wedge , \land

Table 4: Variable-Sized Operators.∑
\sum

⋃
\bigcup

∨
\bigvee∏

\prod
⋂

\bigcap
∧

\bigwedge∫
\int

∮
\oint
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Table 5: Arrows.

← \leftarrow or \gets ←− \longleftarrow ↑ \uparrow

→ \rightarrow or \to −→ \longrightarrow ↓ \downarrow

↔ \leftrightarrow ←→ \longleftrightarrow ↕ \updownarrow

⇐ \Leftarrow ⇐= \Longleftarrow ⇑ \Uparrow

⇒ \Rightarrow =⇒ \Longrightarrow ⇓ \Downarrow

⇔ \Leftrightarrow ⇐⇒ \Longleftrightarrow ⇕ \Updownarrow

7→ \mapsto 7−→ \longmapsto

⇐⇒ \iff (bigger spaces)

Table 6: Log-like Symbols.

\arccos \cos \coth \det \gcd \ln \min \sinh

\arcsin \cosh \csc \dim \lim \log \sec \tan

\arctan \cot \deg \exp \lg \max \sin \tanh

Calling the above “symbols” may be a bit misleading. Each log-like symbol merely produces

the eponymous textual equivalent, but with proper surrounding spacing.

Table 7: Delimiters.

( ( ) ) ↑ \uparrow ⇑ \Uparrow

[ [ or \lbrack ] ] or \rbrack ↓ \downarrow ⇓ \Downarrow

{ \{ or \lbrace } \} or \rbrace ↕ \updownarrow ⇕ \Updownarrow

⟨ \langle ⟩ \rangle | | or \vert ∥ \| or \Vert

⌊ \lfloor ⌋ \rfloor ⌈ \lceil ⌉ \rceil

/ / \ \backslash . (dual. empty)

Table 8: Miscellaneous Symbols.

. . . \dots · · · \cdots
... \vdots

. . . \ddots

∞ \infty ı \imath ȷ \jmath ℓ \ell

∀ \forall ∃ \exists ∂ \partial ∇ \nabla
′ ’ ′ \prime ∅ \emptyset ∠ \angle
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Table 9: Non-Mathematical Symbols.

These symbols can also be used in text mode.

� \dag § \S © \copyright ® \textregistered

� \ddag ¶ \P £ \pounds % \%

Table 10: Math Alphabets.

Example Command Required package

ABCDEabcde1234 \mathrm{ABCDE abcde 1234}

ABCDEabcde1234 \mathit{ABCDE abcde 1234}

ABCDEabcde1234 \mathnormal{ABCDE abcde 1234}

ABCDE \mathcal{ABCDE}

ABCDEabcde1234 \mathfrak{ABCDE abcde 1234} amsfonts or amssymb

ABCDE \mathbb{ABCDE} amsfonts or amssymb
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